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Using the ISIS Driver  The Kodak i1100 Series Scanners provide the ability to process
scanned images to improve their quality by using image processing
features. This can be done by using the ISIS driver which is created
and maintained by EMC Captiva and is provided with the scanner.
Many scanning applications support ISIS drivers and this driver can be
used to interface with them. The ISIS driver is the part of the capture
system which links the scanner to your scanning application.This guide
is for use with the following scanner models: Kodak i1150/i1150WN/
i1180/i1190/i1190E/i1190WN. The procedures are the same for all
scanners unless otherwise noted.

This guide provides descriptions of the options on the tabs of the main
ISIS Driver window and how to set these options. The same features
should be available on the user interface of the scanning application
you are using.
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Starting the SVT 1. Select Start>Programs>Kodak>Document Imaging>SVT

Diagnostics/Scan Diagnostics.
Validation Tool T v 1o B ==

Diriver Types:

T/ AN

T MDS M
sis |

Dirivvers:

EODAK Scanner: i1100

2. Select ISIS for the Driver Type, the Kodak Scanner i1100 as the
Driver, and click OK. The Scan Validation Tool dialog box will be

displayed.
r-‘_ Scan Validation Tool - KODAK 11180 {ISIS) E@g
RO@O|v|E@Ww|laDDDoHmEme o

NOTE: For a description of the icons on the Scan Validation Tool
dialog box, see the next section entitled, “Scan Validation
Tool dialog box”.

[l

3. Click the Setup icon - . The Setup dlalog box will be displayed.

Compreszion

Front Colar: [hone]

Frant Bitonal:

Fear Color:

Fiear Bitonal:

Group-4

2 A-61820 April 2016




4. Click ISIS to display the Preset Configurations window.

KODAKil150onNone o (o]

Preset Configurations
x o

Freset Mame

[Drefault]

Black and *white Perfect Page Document
Color Perfect Page Document

Colar Photoiraih

Description
Default zettings. -

Properties

Image... ] l Scanner... ]

l oK H Cancel ]

b |

The Preset Configurations window saves custom configuration settings.
Each preset is saved locally as an ISIS Driver Preset file with a name
and optional description. Presets can be loaded or deleted from the
Preset Name list, or imported as an IDP file from another location.
There is no limit to the number of presets that can be created.

The Image and Scanner buttons in the Properties field display tabs
associated with configuring the image and scanner settings. See the
sections entitled, “Image options” and “Scanner options” later in this
guide for detailed information.

Icons: Preset Configurations

= | Save Preset — saves your scanner settings for the specified preset
name.
% Delete Preset — deletes the specified preset name and all
—— associated settings.
EJ Import Preset — imports an ISIS Driver Preset (IDP) file.

Help — displays on-line help for the window that is currently

7)
“ displayed.
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Preset Name — displays the available presets.
Description — allows you to add a description of the selected preset.
Properties:

* Image: displays the tabs and options associated with configuring the
image settings.

» Scanner: displays the tabs and options associated with configuring
scanner settings.

OK — closes the window after saving your changes.

Cancel — closes the window without saving any changes.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Scan Validation Tool
dialog box

The Scan Validation Tool (SVT) is a diagnostic application provided by
Kodak Alaris. The SVT user interface allows access to all the features
of the scanner and is a good way to verify that the scanner is working
properly. The Scan Validation Tool allows you to verify scanner
functionality using the ISIS driver.

Scan Validation Tool - KODAK 11180 (ISIS) @M
?«-‘uuTO“—‘u:ll'W|ﬂ| 1 (3

Toolbar buttons

Cd

C o Setup — displays the user interface for the selected driver.
L P Start Scanning — scans the documents in the input tray.
L P Scan One Page — scans only one page.
O Stop Scanning — ends the scan session.
» Change/Open Driver — closes the currently opened driver and

displays the Driver Choice window.

Destination — allows you to select a directory to store scanned
— images and their file names. This option is only available when
Save Images to Files is selected.

-'ff Delete — deletes the files in the destination folder with the file
m name prefix you entered.

a License Key — displays the License Key window.

= No Image Display mode — closes the Image Viewer window

(no images will be displayed).

L1 One Image Display mode — displays one image at a time.

Two Image Display mode — displays two images at a time.

Bl Four Image Display mode — displays four images at a time.
Eight Image Display mode — displays eight images at a time.
o About — displays the About window.
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Image options

Main ISIS Driver The main ISIS Driver window provides a set of 10 tabs. You can select
window each of these tabs and make any choices necessary to meet your
scanning needs. The buttons on the bottom of the window apply to all
tabs.
Properties for KODAK 11150 on None ; @1
Presst: [Defaut](2]
Image Mode Adjustments I Background I Image Edge Fil I Blank Image Detection I About |
-[Norrnal v] Main | Layout I Image Processing I Auto Color Detect I Dropout |
Camera: Dotz per inch:
CETETE | (@ 5
O Frort Image #2 Cropping:
[Fixed To Transport V]
Binarizatior:
Mode: [ iThreshaolding - ]
BackandWhie | Threshold
Grayscale 0
Color
Auto Detect Grayscale
Auto Detect Color
LContrast
U o |
-&0 50
||
[ coy | [ ok ][ cencel |[ Hep |[ Defaut

Image Mode — specifies the mode of configuration.

* Normal: select this option if you want to configure Front Image and/
or Back Image options.

» Merged: select this option if you want one image that contains both
the front side and back side of the document

r~ Image Mode

IMerged j

Image Merge

f+ Front on Top
¢~ Front on Battam
€~ Front on Left
" Front on Right
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Selections are:

Back
Fromt
Front
Back
Front on Top: front side will be above Front on Bottom: back side will be above
the back side within the image. the front side within the image.
Front Back Back Front

Front on Left: front side will be to the left Front on Right: back side will be to the
of the back side within the image. left the front side within the image.

Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image #2,
Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings

independently. Some settings apply only to black and white images,

others apply to color/grayscale images. By selecting the appropriate

Camera and Image Mode, you can control the scanner’s output.

Mode

» Black and White: if you want your electronic image to represent all
elements of your document in black and white.

» Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

» Color: if you want your electronic image to be in color.

» Auto Detect Grayscale: sets auto color detect for grayscale. See the
section entitled, “Auto Color Detect tab” for more information.

« Auto Detect Color: sets auto color detect for color. See the section
entitled, “Auto Color Detect tab” for more information.

Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #2.

OK — saves the values set on all tabs.

Cancel — closes the window without saving any changes.
Help — displays on-line help for the window that is currently displayed.

Default — when selected, the values on all tabs will be reset to the
factory defaults.
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Main tab The Main tab provides the following options.

Properties for KODAK i1150 on None k [
Preset: [Defaut](2]
Image Mods Ad'u.stments I Background I Image Edge Fill I Blank Image Detection I About |
lNorrnaI v] Main | Layout I Image Processing I Auto Color Detect I Dropout |
Camera: Dotz per inch:
Front Image #1 (200 -
O Front Image #2 Cropping:
IFixed Ta Trangport v]
Binarization:
[Thresholding -
Mode:
[Biack and Whie | Threshold
Grayscale 0
Calor
Auto Detect Grayscale
Auto Detect Color
LContrast
U o=
-50 50
N

[ Copy | [ ok ][ cancel |[ Hep |[ Defaut |

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Choose a resolution value from the drop-down list. The default is 200
dpi. Available resolutions are: 100, 150, 200, 240, 250, 300, 400, 500,
600 and 1200 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image. Select one of the following options:

» Automatic: dynamically adjusts the cropping window for different
sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed To Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed To Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled “Layout tab” later for more information.
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» Relative To Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where you want to save a separate color/grayscale or black and
white area. It is useful in applications where a photograph, signature,
embossment or seal appears in a consistent area for an application
(you may want that small area in color/grayscale and the rest in black
and white). To define a zone, select the Layout tab.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

» iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (e.qg., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Threshold
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (e.g., text, graphics, lines, etc.) from the
background information (e.g., white or non-white paper background).
When using Adaptive Thresholding, Threshold and Contrast can be
adjusted.

Threshold — aids in controlling the level at which a pixel is considered
black or white. Decreasing this setting will make the image appear
lighter, and can be used to subdue background noise. Increasing this
setting will make the image appear darker, and can be used to help pick
up light information. The options range from 0 to 255. The default is 90.

Contrast — adjusts the difference between black and white, thereby
making an image sharper or softer. The difference between black and
white is small with a low contrast setting, so the image is softer. With a
high contrast setting, the difference between black and white is large,
so the image is clearer. Select a contrast value from -50 to 50. The
default is O.
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Layout tab The Layout tab provides these options.

Properties for KODAK i1150 on None ‘ @
Preset: [Defaut][2]
Image Mods Adjustments Background I Image Edge Fill I Blank Image Detection I About |
Layout | Image Processing I Auto Color Detect I Dropout |
[Norrnal v]
Camera: Page Size:
Front Image #1 [Scanner's M asimum v]

O Front Image #2
Image Orientation

@ Partrait
() Landscape E
Mode:
—

Black and White

Grayscale
Calor " "
Auto Detect Grayscale FPage Orientation
Auto Detect Color

@ Top edge first

() Bottomn edge first

() Left edge first

() Right edge first

[ Scan frea... ]

[ Copy | [ ok ][ cancel |[ Hep |[ Defaut |

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

* Automatic: the scanner will analyze the content of each document to
determine how it was fed and will rotate the image to the proper
orientation.

Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
To Transport or Relative To Document. See the next section, “Scan
Area dialog box” for more information.
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Scan Area dialog box The Scan Area dialog box allows you to define the amount of image
data which is returned to your PC.

Scan Area [ﬂ_hJ
. 0 1 2 3 4 153 7 a
Page Size Pkt BB B B
Letter - 85217 in v | [ 3 Frant = |
Page Lapout E
@ Portrait C =
Landscape
L] §
o
Area 4 3
V| Shap _ 1
[
% ¥ '
¥ il g 4
width: 81/2" —
Height; 11" 3
Units: g =
Inches T —]
9 3
1
S i
[oea] [
= L =

Page Size — lists the available page sizes. Select a page size that
matches the size of the items to be scanned, or a size closest to the
largest size. Scanning a large area results in image files that waste disk
space by storing unnecessary white space or undesired data (noise).

If the size is not available, select a larger size, and then use the Layout
window to adjust the scanned area to the portion of the page.

All scanners have a page size setting for Scanner's Maximum.
Selecting this size captures the largest image the scanner is capable of
returning.

Page Layout

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

* Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Area

» Snap — enable this option to control the dimensions of the preview
area to fixed 1/8-inch increments. This option is not available in
Pixels mode.

- X: the distance from the left end of the scanner to the left-edge of
the scanning area.

- Y: the position from the top end of the document to the top end of
the scanning area.

- Width: the width of the scanning area.
- Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.
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Image Processing tab The Image Processing tab provides the following options.

Properties for KODAK i1150 on None A [
- —
Preset: [Defaut]i2]
Image Mode Adjustmerts | Background | Image Edge Fil I Blank Image Detection I About |
[Nomal - image Processing | Auto Color Detect | Dropout |
Camera: General Options
T e O Halftone Removal &
O Front Image #2 O irvvert Image =
O Hole Fill -
Mode: Document Type
[Test with Grapics -]
Grayscale
Color Media Type
Auto Detect Grayscale 7 -
Auto Detect Color [F'Ialn el ]
Better
Moize Filker
[Lone Pixel -
Streak Filker
On U 0o
2 2
(|
[ Copy | [ ok ][ cancel |[ Hep |[ Defat

General Options — check the desired options.

» Deskew: automatically straightens a document within +0.3 degrees
of the leading edge of the document. Deskew can detect up to a 45-
degree skew and correct up to a 24-degree angle at 200 dpi or a 10-
degree skew angle at 300 dpi. This option is not available when
Fixed To Transport or Relative To Document is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

» Halftone Removal: enhances images containing dot matrix text and/
or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.

* Invert Image: allows you to select how the black pixels will be stored
in the image. By default the black pixels are stored as black and the
white pixels are stored as white. Turn this option on if you want the
black pixels stored as white and the white pixels stored as black.
NOTE: You may want to change this option if your application

misinterprets the image data and stores your image in
reverse of what you expect.

» Add Border: allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image.

* Hole Fill: allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

12 A-61820 April 2016




» Barcode: allows you to configure the scanner to search your images
for a barcode. The scanner will search each image and decode the
first barcode it finds and return the information to the scanning
application.

The following barcodes can be detected:

Interleaved 2 of 5
Code 3 0of 9
Code 128
Codabar

UPC-A

UPC-E

EAN-13

EAN-8

PDF417

Document Type
» Text: the documents contain mostly text.

» Text with Graphics: the documents contain a mix of text, business
graphics (bar graphs, pie charts, etc.) and line art.

* Photographs: the documents are comprised mainly of photos.

* Media Type — allows you to select the type of paper you are
scanning based on the texture/weight. The options are: Plain Paper,
Thin Paper, Glossy Paper, Card Stock, and Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

» Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

» Superior: the least amount of compression which produces the
largest image size.
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Noise Filter
e None

» Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

* Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vice versa.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g., dirt, dust, or frayed
edges) or by not following the recommended cleaning procedures for
your scanner.

» Check On to set a Streak Filter value. The slider bar allows you to
adjust the extent at which the streaks are filtered. The values range
from -2 to 2. The default is O.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Auto Color Detect tab  The Auto Color Detect tab provides the following options.

Properties for KODAK i1150 an None ‘ =5
Preset: [Default][2]
Image Mode | Adjustments I Background I Image Edge Fill
Nomal | Main I Layout I Image Processing
Camera: Color Content
Front Image #1 off
GlFot inage 22|
FoT TErzii Color Amount Color Threshold
472 50
Mode:
Color Usze the learn mode to determing the proper -
Color Amount for detecting your color
documents. Set the Color Threshold value
and click the Learn button to begin.

Amount Detected: 0
Threshold Detected: O

Learn...

Copy | [ ok [ cancel |[ Hep |[ Defaut

Color Content

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.

* Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

* Low: documents require only a small amount of color to be saved as
color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

« Off: turns Color Content off.
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» Custom: makes the Color Amount and/or Color Threshold options
available.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom to manually adjust Color
Amount and/or Color Threshold.

- Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As
the value of Color Amount increases, more color pixels are
required. Valid values are 1 to 200.

- Color Threshold: the color threshold or intensity (e.g., pale blue
vs. dark blue) at which a given color will be included in the color
amount calculation. A higher value indicates that a more intense
color is required. Valid values are 0 to 100.

Learn — if Low, Medium and High options do not give you the desired
results, use the Learn option.

1. Click Learn and follow the prompts.

2. Place at least 5 representative color documents in the input tray and
click OK. These documents will be analyzed and the recommended
color amount will be calculated for you.

3. Write down the Color Amount and Color Threshold values that
are displayed in the dialog box as these are the settings you will be
required to use in your application.

NOTE: These settings were calculated based on the representative
color documents scanned. If these values do not provide the
desired results for your job, you may need to manually adjust
the Color Threshold.
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Dropout tab

The Dropout tab provides the following options.

Properties for KODAK i1150 on None ==
Preset: [Defaut][2]
Image Mods | Adjustments I Background I Image Edge Fill I Blank Image Detection | About |
[Norrnal v] | Main I Layout I Image Processing I Auto Color Detect | Dropout
Camera: Color Dropout
Front Image #1 Color:
[ Frort Image #2 [NUNE ']
Mode:
Black and White
Grayscale
Calor
Auto Detect Grayscale
Auto Detect Color

[ Copy | [ ok ][ cancel |[ Hep |[ Defaut |

The Dropout tab is used to eliminate a form's background so that only
the entered data is included in the electronic image (e.g., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

Color Dropout

Color — the i1100 Series Scanners can drop out Red, Green or Blue.
None is the default.

- Aggressiveness: allows you to adjust the extent at which the colors
are dropped. The values range from -10 to 10. The default is 0.

A-61820 April 2016

17



Adjustments tab The Adjustments tab provides the following options.

Properties for KODAK i1150 on None 3 =5
-
Preset: [Defaut][2]
Image Mode | I'U'!ain I Layout | Image Processing | Auto Color Detect | Dropout
Adjustments | Backaround I Image Edge Fil I Blank Image Detection I About
[Non‘nal V]
Camera: Color Adjustment
Tt Tl [Manual v]
O Front Image #2
Brightriess: r/} 0 =
Contrast: r[} 0 -
Mode: Sharpen: 1 =
Black and White
Grayscale Colar Balance
Auto Detect Grayscale Automatic - advanced v
Puto Detect Color
Aggressiveness: F/} ] +
2 2
l
[ copy | [ ok [ cacel |[ Hep || Defau
=

Color Adjustment
Brightness and Contrast
* (none)
» Manual: allows you to set specific values that will be used for all
images:
- Brightness - changes the amount of white in the color or grayscale
image. The values range from -50 to 50.

- Contrast - makes the images sharper or softer. The values range
from -50 to 50.

* Automatic: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (e.qg., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting.

Sharpen — increases the contrast of the edges within the image.
Select a value from 0 (no sharpening) to 3.
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Color Balance
* (none)

» Manual: allows you to set specific values that will be used for all
images. The values range from -50 to 50.

- Red - changes the amount of red in the color image.
- Green - changes the amount of green in the color image.
- Blue - changes the amount of blue in the color image.

» Automatic: adjusts the white background of each document to pure
white. This option compensates for the variations that occur between
different weights and brands of paper. This is not recommended for
use with photographs.

» Automatic - advanced: for advanced users that want to further
adjust the Automatic option.
- Aggressiveness - allows you to adjust the extent of the variation.
Increasing this value can help with documents that have yellowed
due to age. The values range from -2 to 2.

NOTE: Color Balance is not available for grayscale images.

1
A-61820 April 2016 19




Background tab The Background tab provides the following options.

Properties for KODAK i1150 on None ==
- —
Preset: [Defaut][2]
Image Mods Main ayout | Image Processing I Auto Color Detect I Dropout |
Background | Image Edge Fill I Blank Image Detection I About |
[Norrnal v]
Camers: Background Smoothing
O Front Image #2
Aggressiveness: r/l 0 -
-10 10
Mode: Foreground Boldness
G%cale
Auto Detect Grayscale Aggressiveness: r,l 0 =
Auto Detect Color =
-10 10
(|
[ Copy | [ ok ][ cancel |[ Hep |[ Defaut |

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color.

Background

* None
» Automatic: smooths up to three background colors.

« Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.

Foreground Boldness — using this option for documents or forms
where you want the foreground (e.g., text, lines, etc.) to be more
prominent.

Foreground
* None
* Automatic: all foreground will be bolder.

e Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent at which the
foreground is determined. The values range from -10 to 10.
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Image Edge Fill tab

The Image Edge Fill tab provides the following options.

(" Broperties for KODAK 1150 on None - |
— —
Preset: [Defaut](2]
Image Mode | Main I Layout I Image Processing I Auto Color Detect I Dropout |
_[No,ma| ,] | Adustments | Background | Image Edge Fil | Blank Image Detection | About |
Camera: Image Edge Fill
Fi olor
O Front Image #2 [Black ']
[ Frame tMode
Left: 0.00in
Mode: Bight: 0.00n
Black and White
Grayscale Top: 0.00 in
Ao Datect Coo Eotan: 00
(|
Copy | oK | [ Cancal || ] [ Defaut |
Image Edge Fill — fills the edges of the final electronic image by

covering the area with either White or Black. Image Edge Fill is

performed after all other image processing options have been applied.
* Fill Color

None
White
Black

Automatic: the scanner will automatically fill the edges of the

image using the surrounding color.

Automatic - include tears: in addition to filling the edges, the

scanner will also fill in tears along the edge of document.

Frame Mode — when you select either White or Black, you can

enter the size of the frame that you want to fill. An equal amount of
the selected color from the Fill Color drop-down list will be filled in on

all sides of the image.

If Frame Mode is not selected, you can select a value in the Left,
Right, Top and/or Bottom area(s) from each side of the scanned

image to be filled with Black or White as selected.

NOTE: When using this option, be careful not to enter a value too

large as it could fill in image data that you want to keep.

A-61820 April 2016

21



Blank Image The Blank Image Detection tab provides the following options.

Detection tab [ Properties for KODAK 11150 on None =z |
Heset [Defaut][2]

Image Mode | Main I Layout I Image Processing I Auto Color Detect | Dropout |

-I Normal v] | Adjustmerits I Background I Image Edge Fil | Blank Image Detection | About

Camera: Blank Image Detection

O Frort Image #2 lEontent ']
EBlack and ‘white
U R
Mode: [ Grayscale I

Black and White - W
cale 1%

Auto Detect Grayscale
Auto Detect Color LColar

J 1% =

1% 100 %

Leam Content

Use the learn mode to determine Image content Amount,

ﬂj Corntent: 0%

[ Copy | [ ok J[ cancel |[ Hep ][ Defau ]

Blank Image Detection allows you to configure the scanner to not give
blank images to the scanning application. Select the image size (KB),
below which an image is determined to be blank. Images with sizes less
than the number you select will not be created. If you use this option,
you must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make an
entry in these fields, all images are kept.

Mode
» Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.
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About tab Displays information about your scanner and driver.

Properties for KODAK i1150 on None ==
— - .
Preset: [Defaut][2]
Image Mods | Main I Layout I Image Processing I Auto Color Detect I Dropout
| Adjustments I Background I Image Edge Fill I Blank Image Detection | About
[Norrnal v]
Camera:

ISIS

O Front Image #2

CERTIFIED

ekil180 Version 1.1.11404.23001
KODAE, i11#x Series Scanner

Mode: Copyright [c] 2014 EMC Corporation |
Black and White QuickDriver Version 2.0.11310.23002 |
Grayscale

Device Information:

Auto Detect Grayscale
Auto Detect Color

EMC, Captiva and 1515 are either registered trademarks or
trademark s of EMC Corporation in the United States and/or
other countries. QuickDriver iz a trademark of EMC
Corporation. Al other trademarks used herein are the property
of their respective owners.

@ Copyright 2014 EMC Corporation. Al rights reserved.

Copy | [ ok ][ cancel |[ Hep |[ Defat
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Scanner options

Scanner tab The Scanner tab provides the following options.
[ Properties for KODAK 1150 on None =)
Preset: [Default][2]
Scanner | Multifeed Detection I Log I About |

Document Feeder

Paper Source:

ADF

FEeeder Pozition

Mormal -

Sheet Counter 1]
Timeout

| 0n

U 5B

1 120 seconds

Response:

| Stop Scanning - |

Document Handling Mormal -

Intelligent Protection: Mone -

b awimum Length: 14"

Power OfF: 15 -

[ ok ][ cancel |[ Hep || Defau

Document Feeder

» Paper Source: looks for paper in the ADF first. If there are no
documents in the input tray, the scanner will scan from the flatbed, if
a flatbed is attached.

NOTES:

» ADF and Flatbed options are only available if you had the flatbed
accessory attached when the scanning application connected to
the scanner.

» The Flatbed Accessory is not available for the Kodak i1150WN
and i1190WN Scanners.

» Feed Position: indicates the position of the input tray. Normal is the
only selection.

» Sheet Counter: enter the number to be assigned to the next physical
sheet of paper entering the scanner. This is incremented sequentially
by the scanner and is returned in the image header.
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Timeout

* On: allows you to set the amount of time the scanner will wait after
the last document enters the transport before the transport timeout
action is taken. You can specify a time delay setting from 1 to 120
seconds.

* Response: indicates the action that will be taken when the document
feeder timeout has been reached.

- Stop Scanning: scanning will stop and control will return to the
scanning application (i.e. ends the job).

Document Handling — indicates how the scanner transports the
documents. Normal is the only selection.

Intelligent Protection — allows you to select how aggressively the
scanner detects documents that enter the scanner incorrectly. This can
occur when documents are not prepared properly for scanning (e.g.,
stapled or paper clipped documents).

* None

* Normal: this is the recommended option as it provides a balance
between minimizing document damage and stopping the scanner
unnecessarily.

* Minimum: select this option if the scanner is stopping too frequently
on documents that you do not want it to detect.

NOTE: Documents may become more damaged before detection
occurs.

» Maximum: select this option to get the least amount of document
damage.

NOTE: This may cause the scanner to stop unnecessarily.
Maximum Length — select a value that indicates the length of the
longest document in your document set.

Power Off — allows you to set the amount of time, in minutes, the
scanner has to be in power saver mode before it automatically turns off.
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Multifeed Detection
tab

The Multifeed Detection tab provides the following options.

- -
Properties for KODAK 11150 on None e e

Preset: [Defaut][2]

Scanner | Multfeed Detection | Log About

Multi-Feed Detection

V| Length Detection

Max Length:
0.00 in

Ao Set
| Ultrasonic: D etection

Sengitivity: Medium -

Action:

[ ok [ cancel |[ Help |[ Defaur |

Length Detection — check this option to select the maximum length of
the document that can be scanned without a multifeed being detected.
Length detection is used when scanning same-sized documents to
check for overlap. For example, if you are scanning 8.5 x 11-inch (A4)
documents in portrait mode, enter a value of 28.57 cm (11.25 inches) in
the Max Length field. The maximum value is 35.56 cm (13.99 inches).

» Auto Set: automatically sets the maximum length value to 1.27 cm
(.50-inch) greater than the length of the currently selected page size.

Ultrasonic Detection — check this option to set multifeed detection.

» Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect labels,
poor quality, thick or wrinkled documents as multifed documents.

- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document. Depending
on the label material, most documents with labels should not be
detected as a multifed document.

- High: the most aggressive setting. This is a good setting to use if all
documents are similar in thickness no greater than 20-Ib. bond
paper.
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Action — select how you want the scanner to perform if it detects a
multifed document.

» Stop scanning: scanning will stop and control will return to the
scanning application (e.g., ends the job). Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

» Continue scanning: the scanner will continue to scan.

» Stop scanning - leave paper in path: scanning will stop
immediately (e.g., making no attempt to clear the paper path) and
control will return to the scanning application (e.g., ends the job).
Clear any documents from the paper path prior to restarting the scan
session from the scanning application.

» Stop Scanning - generate image(s): scanning will stop and control
will return to the scanning application (e.g., ends the job). Image(s) of
the multifed document will be generated. Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

Speaker icon — click the Speaker icon to display the Open dialog box.
From the Open dialog box, select the desired .wav file indicating what
sound you want the scanner to make when it detects a multifeed and
click OK.
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Log tab The Log tab provides a listing of any errors that have been

encountered.
[ Properties for KODAK 11150 on None ==
Preset [Defautt](2]

| Scanner | Multfeed Detection | Lea | About |

KODAE 11150 on None

[ ok |[ cemcel |[ Hep | [ Defaut |

You can either save this information to a file by clicking the Save icon,
or click the Copy icon to copy the contents of the Log file to the
clipboard.
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